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UNNGA DE TYPISKE FEILENE

| OPPSETTET DITT

Etter & ha behandlet flere millioner trykkordre vet vi
at over 90 % av feilene oppstar pa de samme stedene!

Falg guiden vér og du er godt pa vei.

SEKS DESIGNTIPS

Send korrekt bestilling / Korrekte farger / Korrekte filtype / Korrekt opplasning / Plass til beskjeering / Overprint og output

MALER

Vi anbefaler ...

DOKUMENTOPPSETNING

Design uten bruk av malene / De tre beskjeringstipsene / Hvorfor rammer og tekst ikke anbefales

PREMIUM TRYKKFILER

Guide til premium-trykk / Overprint / Overlap / Smé elementer / Mispass / Negativ effekt

EKSPORT AV FILER

Eksportinnstillinger / Slik virker de / Fordelene / Eksport av enkeltsider eller oppslag

SIEKKLISTE INNEN UPLOAD

Seks sjekk, sa er du klar

GRATIS FILSIEKK

Vi er klare til & veilede deg!
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SEKS DESIGNTIPS

1. SEND KORREKT BESTILLING

Husk & opplyse alle bestillingsdetaljer nar du sender ordren din.

Typiske bestillingsdetaljer:

Produkt (hvilken trykksak du ensker)
Opplag (hvor mange du skal bruke)
Ditt telefonnummer — gjerne mobil
Forsendelsesadresse
Faktureringsadresse

* % % % %

Bestill pa www.lasertrykk.no og unngé problemer.
Ved 4 bestille via hjemmesiden er du sikret at vi mottar all relevant informasjon.

2. BRUK KORREKTE FARGER

Vi trykker alt med fire CMYK-farger med unntak av enkelte trykksaker med Pantone-farger.

Husk trykkfil i CMYK-farger
| de fleste grafiske programmer kan du velge & arbeide i CMYK-farger
(fremfor RGB-farger).

Last ned var CMYK-guide
Last ned var CMYK-guide, hvor du finner et bredt utvalg av CMYK-fargeprover.
Du kan laste ned fargemapper pa www.lasertrykk.no/fargefolder.

Slik defineres fargen sort
Skal du definere fargen sort (til dekkflate) med CMYK-farger, far du best resultat ved a velge:
C=60 M=40 Y=40 K=100. Sort tekst og strek-tegninger skal defineres som C=0 M=0 Y=0 K=100.

Pantonefarger
Som nevnt trykkes enkelte av vare trykksaker med Pantone, dette er spesialfarger som ikke kan skapes med
CMYK-skalaen. Dette gjelder alltid offsettrykksaker som konvolutter og brevpapir, disse skal ha en eller flere
Pantone-farger.
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3. BENYTT KORREKT FILTYPE

Vi kan héandtere alle filtyper, kjente som ukjente. Det beste resultatet far du hvis du benytter .E: \
PDF-format med alle fontene inkludert i filen.

ANDRE POPULARE FILTYPER

gz | Tif/jpg
44 | Inesten alle grafiske programmer kan man lagre i bildeformatene tif og jpg.
Lagre filen i maksimumkvalitet, i CMYK-farger og min. 300 dpi.
Er det tekst pa trykksaken anbefaler vi min. 600 dpi for optimal skarphet.

. Eps
==
/" Et populaert vektorformat som typisk gir bedre resultat enn tif/jpg. Husk & konvertere alle fonter til kurver (vektorisert/
outlined). Fonter kan ogsa veere inkludert i filen.

oon < InDesign, Photoshop og Quark
! Eksporter til PDF-format — se ovenfor. Alternativt eksporter til eps, og pn eps-filen i lllustrator, konverter alle fonter til
outlines, og lagre som eps/PDF.
[ DOC |
2

Microsoft Office (Word, Excel, PowerPoint, Publisher)
Utskriv til PDF-format (krever Adobe Acrobat eller var gratis PDF-writer — se download-seksjon).

Husk at Microsoft Office-formatene ikke er beregnet til grafisk bruk, og vi patar oss ikke ansvaret for fargene i den
endelige trykksak.

Gratis PDF-generator
P& www.lasertrykk.no/downloads kan du downloade en gratis PDF-writer og selv lage PDF-filer.

4. KORREKT OPPLASNING (PPI)

Ved & bruke korrekt dpi unngar du at din trykksak blir kornete og uskarp. Som utgangspunkt skal trykkfiler
ligge i 300 ppi. Vi anbefaler dessuten & ikke lage tekst som bitmap.

DPI eller PPI1?
Selv om DPI (punkter per tomme) og PPI (piksler per tomme) vilkérene begge beskriver
opplgsningen (eller klarheten) av et bilde, er de ikke det samme.

PPI beskriver antall piksler som vises per tomme pa en skjerm.
DPI brukes til utskrift, og beskriver antall fysiske prikker med blekk pa trykksaker.

* Bilder og leseavstand, f.eks en folder (10-50 cm): min. 150 ppi — 300 ppi for optimalt resultat.

* Bilder pa staavstand, f.eks plakater, roll-ups og liknende (min. 50 cm): min. 60 ppi — helst 100 ppi.

* Bilder pa bannere, som leses pa flere meters avstand: 5-50 ppi avhenging av om leseavstanden er
5 eller 20 meter.

5 ppi heres helt tullete ut, men faktisk betyr det at hver pixel er 0,5 x 0,5 cm — en sa liten prikk kan man ikke
se pa 20 meters avstand — derfor kan 5 ppi vere helt fint.
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9. HUSK PLASS TIL BESKJARING

Dette er det viktigste radet, da det er her vi opplever flest feil.

Ekstra 3 mm i layoutet
Det viktigste er at du husker a legge til 3 mm pa alle sider av trykksaken, ogsa kalt "bleed”.
Tekst og grafiske elementer bgr ha en sikkerhetsavstand pa minst 3 mm fra den siste kanten av trykksaken.

Se var videoguide her, som viser Se ogsa videoen var her og forsta hvordan
hvordan du lager beskjeering i InDesign. minimale svingninger kan pavirke designet ditt.

Unnga problemer med beskjeering ved & benytte en av vare maler.
Se flere beskjeeringstips i dokumentoppsetting.

6. OVERPRINT 06 OUTPUT

Unnga a bli overrasket over at noe forsvinner!

Overprint Ikke overprint
InDesign, lllustrator og Acrobat kan stilles inn til & alltid vise overprint

- dermed vil du oppdage eventuelle problemer med layoutets fargelag. "

Overprint i InDesign og lllustrator:

Sl& pa Overprint Preview i InDesign s& vil alt layout simulere det ferdige trykket:

InDesign > View > Overprint Preview.
Se quide.

Overprint i Acrobat Pro:
Oppdag feil ndr den trykkeklare PDF-en gjennomgas. Det anbefales & alltid ha overprint-visning slétt pa:
Edit > Preferences > Page Display > Page Content and Information > Use Overprint Preview > Always.

Se quide.

Output Preview-verktoy i Acrobat:
Du kan ogsé bruke Output Preview som verktgy. Sla pa “Simulate Overprint” i Acrobat:
View > Tools > Print Production > Output Preview > Simulate overprinting.

Se quide.
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MALER

Vi anbefaler at du bruker en av vare maler nar du designer din trykksak.
Nar du benytter malene unngar du problemer med beskjaering, dokumentstarrelse m.m.

Malene er plassert i en ZIP-fil, hvor du finner:
* Mal i PDF-format

* Mal i InDesign-format [u] [w]
* Vare eksport-innstillinger

* Dokumentet "Slik designer du din trykksak.pdf” = r
o .. . o ‘ E - [
Du far tilgang til alle maler pa www.lasertrykk.no/maler. —
Download

DOKUMENTOPPSETNING

Slik gjer du det hvis du ikke vil bruke malene vére.

1. Start et nytt dokument

Kan ogsa hete "ny side”, ”nytt canvas” eller "nytt artboard”.

Maler

. - Beskjeeri
2. Dokumentoppsetning - InDesign Bakgrumsgrafi og bakgrunnsfarger

skal ga helt ut til kanten, det vil si 3 mm

Sett dokumentstarrelsen til trykksakens ferdige mal; f.eks. visittkort (85 x 54 mm). utover den endelige kant.

Endelig kant
Endelige format pa trykksaken etter beskjeering.

3. Innsett 3 mm beskjaeringssone og 3 mm sikkerhetssone A

Dette gjeres i menyen "Nytt dokument”, "Beskjeer og rate linje”. Tokst, bidor ogogoer barplasseres
4. Dokumentoppsetning — andre programmer

Sett dokumentstarrelsen 3 mm starre enn trykksakens endelige starrelse pa alle fire sider.

Dette kalles & "tillegge beskjaering”.

Eksempel pa tillegg av 3 mm beskjeering:

Trykksak Ferdig mal | Dokumentstorrelse
Visittkort 85 x 54 mm 91 x 60 mm
A6-postkort 105 x 148 mm 111 x 154 mm
A5-flyer 148 x 210 mm 154 x 216 mm
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DE TRE BESKJARINGSTIPSENE

Hvis nedenstéende tre beskjarings-tips falges, vil det sjeldent oppsta feil.

TIPS 1
Design filen i korrekt starrelse fra

begynnelsen av!

Layout-format
Endelig format: (arbeidsomrade):
A0-format (841 x 1189 mm) 847 x 1195 mm
Al-format (594 x 841 mm) 600 x 847 mm
A2-format (420 x 594 mm) 426 x 600 mm
A3-format (297 x 420 mm) 303 x 426 mm
A4-format (210 x 297 mm) 216 x 303 mm
A5-format (148 x 210 mm) 154 x 216 mm
AB-format (105 x 148 mm) 111 x 154 mm
A7-format (74 x 105 mm) 80x 111 mm
Visitkort (54 x 85 mm) 60 x 91 mm

TIPS 2

Grafikk som skal ut til kanten skal fylle hele arbeidsomradet!

Feil plassering av bakgrunnsgrafikk

Korrekt plassering av bakgrunnsgrafikk

Chariothe Miglsen
Gratikar

C LaserTrykK-no
Birger Olivers vei 11

1176 Oslo

TIf:22237070

Mobil: 22 23 70 70

E-post: navn@firmanavn.no

TIPS 3
Ikke plasser tekst for neer kanten!

Feil tekstplassering — riktig bakgrunn

Chariotte Nislasn
Graticsr

C LaserTrykK-no
Birger Olivers vei 11

1176 Oslo

TIf: 22237070

Mobil: 22 23 70 70

E-post: navn@firmanavn.no

Charlotie Nislsen
Grafiker

CLaserTrykK-no
Birger Olivers vei 11

1176 Oslo

TIf: 22237070

Mobil: 22 23 70 70

E-post: navn@firmanavn.no,

C LaserTrykK-no
Birger Olivers vei 11

slo

TIf.: 222370 70

Mobil: 22 23 70 70
E-post: navn@firmanavn.no
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HVORFOR RAMMER 0G TEKST IKKE ANBEFALES

Se hvordan et "skjevt” kutt pa bare 1 mm pévirker et layout som ”i teorien” er greit.
Hvis vi kunne kutte mer presist enn +/- 1 mm, var 3 mm for beskjaering ikke nedvendig — men det er det.

.|
Teori: Rammen skal veere 2 mm bred
over alt.

Teori: Rammen skal sitte 3 mm fra kanten
hele veien rundt.

Kjell Kalmar

Chef
Virksomhet TIf.: 88 88 88 88
Adresse 99 Mobil: 88 55 88 55
1176 Post kode navn@virksomhet.no

Teori: Den hgyre- og venstrestilte teksten
skal veere plassert 3 mm fra kant.

Praksis: Rammen kommer til & veere
109 3 mm bred.

Praksis: Rammen kommer til & sitte
2 09 4 mm fra kant.

Kjell Kalmar

Chef
Virksomhet TIf.: 88 88 88 88
Adresse 99 Mobil: 88 55 88 55
1176 Post kode navn@virksomhet.no

Praksis:Teksten kommer til 4 sitte
2 0g 4 mm fra kant.
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PREMIUM TRYRKFILER

Selv om vi er store tilhengere av at det skal veere enkelt, stiller denne typen foredling noen krav til trykkfilen
din. Denne korte guiden tar utgangspunkt i InDesign, men prinsippene er de samme uansett hvilket (egnet)
program som benyttes til utarbeiding av trykkfiler.

Vi kan péfere tre effekter:
* Gulifolie
*  Sglvfolie
* 3D-lakk

= Farveprower

Hver effekt som brukes skal defineres i trykkfilen som en unik spottfarge (staf- ;
fasjefarge). Hvilke farger som brukes til de forskjellige effektene er underordnet, Bl o1 e
men optimal kontrast til selve trykkfilen er en fordel. Ei [fngen]

SILVER

VAMHISH

Delvis lakk navngis «VARNISH», sgivfolie «SILVER» og gullfolie «GOLD»
- alltid med store bokstaver.

OVERPRINT

Overprint skal alltid brukes pé de delvise elementene, uansett om det ligger trykkfarge
under effekten eller ei.

OVERLAP

Effekter som overlapper skal sla hull, sa det ikke legges flere lag oppé hverandre. Det skyldes at det brukes
lakk som kleber pa folien og lag med overlap vil derfor bli for tykke. Fig. A1 til venstre viser de tre variantene i
den ferdige filen. Fig. A2 viser elementene trukket fra hverandre.

Fig. A1 Fig. A2

A N

»

@ VARNISH (lakk) @ SILVER (solv) GOLD (gull)

SMA ELEMENTER

Veer oppmerksom pa at delvis lakk og folie fungerer best, hvis elementene ligger minimum 3 mm fra
hverandre, fra kanten og/eller brett (fold). Vi anbefaler ikke punkisterrelser under 12 pkt.

LaserTrykK-no




Da hver effekt legges pa trykkarket i en serskilt arbeidsgang, sa kan mispass forekomme pa elementer med
liten toleranse (fig. B1). Serg alltid for & ta hpyde for dette i designet. Fig. B2 viser et mispass pa kun 0,3 mm.

Fig. B1 Fig. B2

@ VARNISH (lakk) @ SILVER (solv) GOLD (gull)

NEGATIV EFFEKT

@nskes negativ effekt i folien skal elementer, eksempelvis tekst som vist til hgyre (Fig. C1), ha en viss
toleranse. Gullfolien overlapper den bakenforliggende grafikken, samtidig som det er tatt hgyde for mispass.
Fig. C1 er laget med en hvit kasse som bakgrunn (Fig. C2).

Samme oppgave kan ogsa lgses med en stroke (Fig. C3).

Ficipiet fuga. Mint
occusa que plignis et
ad eatem rerum aut
et andis est, quam
ratem quam lia niet
labor alMo tem inc-
tem. Dam alibusdae

Fig. C1 Fig. C2 Fig. C3
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FARGEPROFILER

* Til bestrgket (coated) papir, f.eks. Silk, anbefaler vi FOGRA39.
* Til ubestrpket (uncoated) papir, f.eks. offset, anbefaler vi FOGRA47.

EKSPORT AV FILER

Vi anbefaler, at du laster ned og installerer vare eksportinnstillinger, hvis du designer din trykksak med hjelp
av Adobes programmer (InDesign, lllustrator og Photoshop).

1. Download zip-fil og pakk den ut

2. Dobbelt-klikk pa filen ”LaserTryk.dk.joboptions”

3. Eksport-innstillingen er na installert og finnes i din InDesign-menu.
4.Velg "File” — "Adobe PDF Presets” — "LaserTryk.dk”

Download eksportinstillinger i QR-koden eller her: www.lasertrykk.no/downloads.

FORDELEN VED EKSPORTINNSTILLINGER

Nar du bruker vare eksportinnstillinger, er du sikret at det er styr pa:

Problemer med transparens

Problemer med beskjaering

Problemer med manglende fonter
Problemer med ungdvendig hay opplasning

KORREKT EKSPORT - ENKELTSIDE ELLER OPPSLAG

Nar du eksporterer trykkfilen fra InDesign, kan du velge & eksportere sidene = ‘m— — r
som enkeltsider eller oppslag. s ﬁ v v

* Storstedelen av trykksakene mé eksporteres som enkeltsider i ett dokument (pdf)
og i riktig rekkefalge.

* Omslag og foldere skal eksporteres som oppslag i ett dokument (pdf),
og sidene ma veere riktig sammensatt.
Husk & sette inn en rygg, hvis det er en limt bok.

Enkeltsidet

4 3
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SIEKKLISTE INNEN UPLOAD

I Korrekt beskjaering
Jeg har lagd korrekt beskjaering og min trykkfil er 3 mm sterre pa alle kanter enn den endelige trykksak.

1 Korrekt sikkerhetssone
Jeg har plassert tekst, grafikk og logoer innenfor sikkerhetssonen (minimum 3 mm fra trykksakens kant).

I Korrekt opplesning

Alle bilder i min trykkfil har en opplasning pd minimum 300 dpi, nar de er plassert i 100 % i dokumentet.
Psssst... Er du i tvil om oppl@sningen er god nok, forstarr skjermen din til 200-300%.

Hvis det fortsatt ser skarpt og ikke-pikselert ut, vil det ogsa se fint ut pa trykk.

1 Korrekte farger

Min trykkfil er lagd med CMYK-farger. Har jeg innsatt bilder eller annet i RGB/Pantone-farger, lar jeg
LaserTrykk.no konvertere til CMYK-farger, for a fa det beste resultat.

Jeg er Kklar over at fargene kan endre seg ved konverteringen.

VI Korrekte PDF med fonter inkludert

Alle fonter ble embedded/inkludert, da jeg eksporterte min PDF-fil.

Benytter du vare eksportinnstillinger (se her) eller eksporterer du som "high quality” / ”press quality”,
skjer dette automatisk.

I Ingen oppslag (ved trykksaker med flere sider)

Min PDF-fil inneholder sidene fortlopende. Et 24-siders hefte krever derfor en PDF-fil med 24 sider.
Fremsend derfor ikke PDF-filer med sidene plassert overfor hverandre / som oppslag.

GRATIS FILSJEKK

Er du i tvil om filen din kan brukes til utskrift, tilbyr vi & sjekke den for trykk — gratis og uforpliktende.

Vi sjekker din fil for: /
* Korrekt beskjeering
* Korrekt opplasning (dpi) (| PDF A

* Format / filtype
* Korrekte farger

Se mer pa www.lasertrykk.no/filsjekk.
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